
Media Vision Windows Software Release 1.44

1. Overview

This release of Media Vision's software for the Pro AudioSpectrum family of products, 
which includes the CDPC and the CDPC XL, contains enhancements and new 
functionality in several key areas:

* Virtual Services
* Mixer Configuration
* IRQ and DMA Channel Setup
* Pocket Recorder
* Pocket CD
* MV.INI

2. Virtual Services

Media Vision's virtual device driver for Windows allows your Windows and DOS 
software applications to share the Pro AudioSpectrum hardware without the ensuing 
conflicts that may cause one or more of the applications to terminate prematurely.   In 
general, this enables you to load and run Windows and then use the DOS shell within 
Windows to run any DOS-based games, applications, and/or multimedia titles you have 
loaded on your system.

NOTE: Not all games and/or applications can be run in a DOS shell from Windows.  If 
you experience difficulty with one or more applications in this regard, it is 
recommended that you contact the software vendor for an updated version of the 
software, or for further technical assistance. 

Generally speaking, running Windows in enhanced mode allows you to have a DOS 
application active (in a DOS shell) at the same time with one or more Windows 
applications.  And if the active DOS application is using the Pro AudioSpectrum 
hardware, it must share it with any Windows applications that also want to use it.  
However, since only one software application is able to use the audio hardware at a time, 
Media Vision's virtual device driver for the Pro AudioSpectrum will block access to the 
hardware until the first application is finished using it.  This is one of the fundamental 
requirements of supporting multitasking, and  it prevents harmful conflicts from arising 
out of the shared use of the hardware.

The basis of this scheme is the rule that the application currently using the hardware has 
first precedence.  Thus, if you are running a DOS-based game from the DOS shell in 
Windows that is actively playing digital audio (also known as 'waveform'), Windows 
applications will not be able to play digital audio until after the game has stopped playing
it.  For example, if you first launched a DOS-based game from Windows and it started 
using the Pro AudioSpectrum hardware for playing waveform sounds, then the sound 



from your alarm clock in Windows would not be heard until after the waveform from 
your DOS game finished playback.  However, if your DOS game was not playing 
waveform at the time the Windows alarm clock went off, the audio from your alarm clock
would be heard!  Likewise, if you are using a Windows application to playback 
waveform sounds when you launch a DOS game from Windows that tries to play 
waveform sounds, the Windows application takes precedence and its waveform sounds 
will continue until they are finished.  Once they are finished, the DOS game will be able 
thereafter to play waveform sounds.  

3. Mixer Configuration

The analog audio mixer on the Pro AudioSpectrum is controlled by the Windows device 
driver program MVMIXER.DRV.  This program is the equivalent in Windows of the 
DOS device driver MVSOUND.SYS, and provides control of both volume and 
play/record modes for each audio channel, as well as overall equalization settings. With 
this release MVMIXER.DRV has enhanced to allow the user to save certain driver 
configuration settings to a Media Vision specific file, MV.INI, in Windows' home 
directory.   These settings are accessed from the Control Panel as follows:

a)  Start the Control Panel
b)  Start the Drivers applet within the Control Panel
c)  Select the entry "Pro AudioSpectrum/CDPC Mixer"
d)  Press the "Setup" button.

The options offered are:

Inherit DOS settings

Selecting this option directs the Windows audio mixer driver to use the mixer 
settings that were being used in DOS at the time Windows was started.  For 
example, if you set the record level for the microphone at 100% in DOS using the 
PAS.EXE program, the same record level will be retained by the Windows mixer 
driver when Windows starts.
 
Restore DOS Mixer settings

If this option is selected, when you exit from Windows the Windows mixer driver 
will restore the audio mixer settings that were being used by DOS applications 
when Windows started.  For example, if the record level for the microphone is set 
at 100% in DOS using the PAS.EXE program, and is changed to 50% while being
used in Windows, the Windows mixer driver will return the record level for the 
microphone to 100% when you exit from Windows.  

Save Windows Mixer settings

If this option is checked, upon exit the audio mixer settings used in Windows will 
be saved so that they can be restored the next time Windows starts.  However, if 



the user has also checked 'Inherit DOS settings', the DOS settings will override 
this option.

Allow Microphone And Monitor To Be Active Simultaneously

If this option is selected, both the microphone level and the monitor level on the 
CDPC and the CDPC XL can be raised (active) simultaneously.  Ordinarily, the 
default condition of the Windows mixer driver is set to the opposite of this state to
prevent feedback from the CDPC's built-in speakers through the microphone on 
the front panel of the CDPC.  If you choose to allow both audio channels to be 
active, be careful not to raise the record level for the microphone too high as the 
feedback can be very loud.  To avoid this happening, it is suggested that you 
gradually elevate the level settings until you obtain the proper balance without 
causing undue feedback.

4. IRQ and DMA Channel Setup

(Note: Herein IRQ refers to Interrupt Request)

Media Vision's virtual device driver and waveform (digital audio) drivers for the Pro 
AudioSpectrum products have been modified to alleviate potential IRQ conflicts between
games or applications that are running in a DOS shell from Windows, and Windows 
applications.  

The Windows waveform driver now retrieves the IRQ setting used by 
MVSOUND.SYS during Windows' system start-up, and uses it for record and playback 
of waveform data.  Thus, the IRQ setting associated with MVSOUND.SYS overrides any
IRQ setting that may have been assigned to the Windows driver either by manually 
editing Windows' SYSTEM.INI file, or by using the Drivers applet in the Control Panel.  
This scheme is the only practical way to avoid IRQ conflicts between Pro AudioSpectrum
applications running simultaneously in DOS and Windows.

To change the IRQ setting used by Media Vision's Windows waveform driver modify the 
device load line in CONFIG.SYS using either the DOS installation program provided 
with your Pro AudioSpectrum product, or by manually editing the file.  An example of 
the device load line in CONFIG.SYS before and after modification is:

Before: device=c:\proaudio\mvsound.sys /d:3 /q:7 /j:1

After: device=c:\proaudio\mvsound.sys /d:3 /q:10 /j:1

In the example above the second line changes the IRQ setting from 7 to 10.  This change 
will be automatically utilized by the Windows waveform driver the next time Windows is
started after the machine is rebooted. 

If it is necessary to use a different IRQ in Windows than in DOS, the MVSOUND.SYS 



device driver load line should be modified so that it begins with a remark statement.  This
will prevent the device driver from loading.  An example of the device load line in 
CONFIG.SYS before and after modification is:

Before: device=c:\proaudio\mvsound.sys /d:3 /q:7 /j:1

After: rem device=c:\proaudio\mvsound.sys /d:3 /q:7 /j:1

The DMA Channel setting used by the Windows waveform driver does not have to match
the setting used by MVSOUND.SYS.  Any changes made to the  DMA Channel setting 
that are made in Windows using the Drivers applet in the Control Panel will be reflected 
in the Windows system file SYSTEM.INI, and will be utilized by the waveform driver for
record and playback of waveform data.

5. Pocket Recorder

Several new editing features and functions have been added recently to Pocket Recorder 
to allow for more flexibility in editing and using recorded waveform data.  In addition, 
the file function 'Set Temp Directory has been added so that the temporary storage 
directory on disk volumes which are filling up (something likely to happen if you are 
accumulating multimedia data) can be moved to disks and volumes which have more free
storage space.  These new additions to Pocket Recorder include:

Drag and Drop

Pocket Recorder now supports drag and drop of waveform files (i.e., files that 
contain the .wav file extension).  To use this feature place Pocket Recorder in a 
minimized state on the Windows desktop.  Then, select one or more waveform 
files, e.g., using Windows' File Manager, and drag and drop the selected group to 
Pocket Recorder and release.  Pocket Recorder will play It is now possible to 
select a region of the wave file by clicking down on a mouse button while in the 
waveform view area, and, while continuing to hold the mouse 

Selecting A Region Of The Waveform File

It is now possible to select a region of the wave file by clicking down on a mouse 
button while in the waveform view area, and, while continuing to hold the mouse 
button down, moving the mouse to a new position within the same view area.  
Similarly, 'shift-click' selection is possible by simultaneously holding down the 
SHIFT key and clicking the mouse button at a point in the waveform view area.  
This will select a region between the current position and the position where the 
mouse was clicked.

This functionality works similar to the selection functionality found in many word
processors in selecting a region of text, with the exception that you cannot scroll 
the waveform view while you are selecting (i.e., you cannot hold down the mouse
button and drag the mouse cursor outside of the waveform view area to cause the 



waveform to scroll). 

When the waveform view area is in 'zoomed-in' mode, it is possible to select a 
region larger than what can be displayed in the view area.  To do this, use the 
following 'SHIFT-click' functionality:

a, Set the current-position-cursor (the red line in the waveform view area) to 
the beginning of the region you wish to select.

b, Scroll the view area to the part of the waveform where you want the 
region to end.  

c, While holding down the SHIFT key, simultaneously click on a mouse 
button, and the region between the current position (which may have 
scrolled out of view), and where you clicked the mouse, becomes the 
selected region.

Note that if there currently is a region selected, clicking on any mouse button in 
the waveform view area will remove that selection.  This does limit selecting to 
one zoom mode at a time.  That is, you cannot select a region in 'zoomed-in' 
mode, then zoom-out while maintaining that selection, because to zoom-out you 
must double click on the waveform view window, which will remove any defined 
selection.

Cut, Copy, Paste And Delete (Edit Functions)

The options in previous versions of Pocket Recorder which allowed limited 
editing of a waveform data have been replaced with standard Cut, Copy, Paste, 
and Delete options.

To use Cut, Copy, and Delete, select a region of the wave file and use one of 
options in the Edit menu to perform the desired action.  These options behave 
similarly to other windows applications:  Cut will  copy the deleted region to the 
clipboard, then delete the region from the wave file; Copy will simply copy the 
selected region to the clipboard; Delete will delete the selected region from the 
wave file without affecting the contents of the clipboard.

To use the Paste function, place the current-position-cursor at the position in the 
waveform view area where you want the paste to occur, and select the Paste 
option from the Edit menu.  The Paste functionality differs slightly from many 
standard Windows applications in that it is not possible to paste into a region.  
Instead, the waveform data which is pasted will be placed starting at the current 
position, and is appended to any selection currently defined.  

Please note:  It is only possible to paste data which is of the same format as the 
waveform which is being displayed.  Format includes sampling rate, bits per 
sample, and number of channels.  You cannot paste a 44kHz, 16 bit, stereo format 



into a 22kHz, 8 bit, mono file.  Functionality to enable pasting different waveform
formats will be added in a future release of this application.

Set Temporary Directory

Through the Set Temp Directory option in the File menu you can set the directory 
in which the application will create it's necessary temporary files.

In previous versions of Pocket Recorder, the directory for temporary files was 
derived from the TEMP environment variable in DOS.  Because people often
set this variable to a RAMdrive of limited size, it unnecessarily constrained the
size of recordings and/or file editing operations that could be performed by Pocket
Recorder.

The Set Temp Directory option makes it possible to bypass the TEMP 
environment variable by specifying a temporary directory which will be used only
by this application.

To use this option, perform the following steps:

a, Select the Set Temp Directory option in the File menu.

b, If a file is loaded and has been modified, a message box querying whether 
the modifications should be saved will appear.  Either the Yes or No option
must be chosen to change the temporary directory.

c,  A Set Temp Directory dialog box will appear in which it is possible to 
select the current drive and directory for the applications temporary files.

Selecting the OK button in this dialog box will cause the applications temporary 
files to be recreated on the newly specified drive and directory.  Selecting the 
Cancel button in this dialog will cause the application to ignore any changes made
to the specified drive and/or directory.  Selecting the Remember check box makes 
it possible for the specified temporary drive and directory to be remembered in 
future instances of the application.

As an example, if  volume D: is a RAMdrive, and the TEMP environment 
variable
in DOS is set to a directory on this drive, it may be desirable for this application's 
temporary files to always be created on C:\TMP (or in some other directory not on
the RAMdrive).  In this case, use the Set Temp Directory dialog box to change the
drive and directory to the desired settings, and check the Remember check box, 
then click on the OK button.  If the application is able to create a file in the 
assigned directory, all future instances of the application will default to the new 
temporary directory just defined.

It should be noted that in the design of  Pocket Recorder a trade off was made 



between speed of execution and the size of waveform files which can be recorded 
or edited. Because the ability to handle large files was considered a primary 
design criterion, all editing changes are stored in a temporary file which is 
essentially a mirror image of the original file, plus (or minus) any modifications.  
This makes the Revert option possible - by simply reinitializing the temporary file
- and makes large amounts of editing possible, since changes are not stored in 
memory.

6. Pocket CD (Requires a CD-ROM Drive) 

Pocket CD is a new application from Media Vision that is included with Media Vision's 
upgrade kits, including the Pro Multimedia System.  It has been included with the Pro 
AudioSpectrum 16 package so that end-users who already have a CD-ROM drive can 
also use it to control their CD-ROM drives like a Compact Disc player.

NOTE: If you see the message "There is an undetectable error in loading the specified 
device driver!", it is possible that one of the Microsoft Windows device drivers 
that is utilized by Pocket CD, [MCI] CD Audio, is not installed and/or loaded.  
Use the Drivers applet in the Control Panel to add the driver; the driver is found 
on Microsoft Windows Installation (Setup) Disk #4. If the driver and CD-ROM 
drive are installed correctly, the driver will display a message indicating that it has
sensed the presence of the CD-ROM drive.

The major features of Pocket CD include controls for governing play of Compact Discs 
in a CD-ROM drive, as well as functions for creating and saving play lists (i.e., the tracks
displayed in the track calendar).  Also, Pocket CD has the unique capability to recognize 
Compact Discs previously played with the Pocket CD program.  The following 
information covers the basics of Pocket CD.

CD-ROM Control Functions

a, Play - Starts playback of currently selected track.  If no track is selected 
playback will begin with the first track displayed in the track calendar.

b, Previous Track - Moves current playback position to the start of the 
previous track.  The CD-ROM drive must be stopped for this function to 
work.

c, Next Track - Moves current playback position to the start of the next track.
The CD-ROM drive must be stopped for this function to work.

d, Pause - Pauses playback of CD audio at the current playback position.  
Press this button again, or the Play button, to resume play.

e, Stop - Stops playback of CD audio from the CD-ROM drive and resets the
current playback position to the first track displayed in the track calendar.



f, Eject - Ejects the Compact Disc from the CD-ROM drive.

g, Linear/Random Play (Shuffle Button) -  Playback of CD audio can be 
either sequential (the button looks like a staircase) or shuffled (the hashes 
on the button appear dispersed) .  If linear playback is chosen CD audio 
will play sequentially from the first track in the track calendar to the last, 
in the order the tracks appear in the calendar.  If  shuffle play is selected, 
playback of CD audio will be unpredictable; tracks appearing in the 
calendar will be played back at random (however, they will be repeated if 
looping is selected).

h, Continuous Play (Looping) - Playback of CD audio will loop continuously
through the tracks displayed in the calendar.  The order of playback is 
determined by whether linear or shuffle play is selected. 

i, Cueing - The cue button sets the current playback position for CD audio 
and places the CD-ROM drive in a paused ready state.  When you press 
the record button in Pocket Recorder, Pocket Recorder will send a 
message to Pocket CD to begin playback of CD audio from the cue point.  
When the Stop button in Pocket Recorder is pressed, the current playback 
position in Pocket CD is reset to the cue point and the CD-ROM is 
returned to a paused ready state. 

Creating And Saving Play Lists

a, Add Songs - This function allows you to add a song(s) to your play list.  
Adding a song to the play list cannot be performed unless CD audio 
playback is stopped. 

b, Delete Songs - This function allows you to delete a song(s) from your play
list.  Deleting a song from the play list cannot be performed unless CD 
audio playback is stopped.

Selecting And Modifying CDs

a, Select CD - This function allows you to select a play list that has been 
saved previously.

b, Modify CD - This function allows you to enter the title and/or name of the
artist for the current CD, as well as the title of each individual track.  This 
information is saved along with the play list information for the CD.  
Thus, the next time you insert the CD in your CD-ROM drive, Pocket CD 
will recall the information you entered previously and will automatically 
associate it the CD. 



7. MV.INI

The configuration options for Media Vision's mixer driver are now stored in the file 
MV.INI, which is located in Windows' home directory.  For example, the following are 
the default settings for the audio mixer in MV.INI:

[mvmixer.drv]
SaveSettingsOnWindowsExit=NO
WindowsUsesDOSSettings=YES
RestoreDOSSettingsOnWindowsExit=NO
CDPCMicOverride=NO


